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the Developer tab. The Developer tab is not shown on the 

Excel toolbar by default but can be turned on by going to 

File | Options | Customize Ribbon and checking 

“Developer” under the “Main Tabs”. The code can then be 

viewed by clicking on "View Code": 

 

Figure 11. Developer Tab. 

 

 
 

The main code can be found by double clicking on the 

Module "MainApplication": 

 

Figure 12. Main Application Location. 
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The Securities and Exchange Commission (SEC) has 

upgraded the existing system of Electronic Data Gathering, 

Analysis, and Retrieval (EDGAR), to Interactive Data 

Electronic Applications (IDEA) platform, using eXtensible 

Business Reporting Language (XBRL). In January 2009, the 

SEC issued its final mandate for XBRL adoption and the 

conversion target dates for all firms. This conversion 

enables users to retrieve listed companies’ financial 

statement information at two levels, document and the data 

element, compared to the document level alone under the 

existing system of EDGAR. Beneficial to all users, this 

change is particularly important to resource-strapped 

entities such as small businesses, and universities. The 

result is user friendly for students researching information. 

With simply the industry standard tool of Microsoft Excel, 

without expensive proprietary XBRL modules, detailed 

information is now available, quickly, efficiently and at 

minimum cost. This paper explains the basic concept of 

XBRL and demonstrates the ease of the retrieval process in 

Microsoft Excel. 

 

INTRODUCTION 

 

On January 30, 2009, the Securities and Exchange 

Commission (SEC) chairperson, Mary Schapiro, announced 

the agency’s final mandate for eXtensible Business 

Reporting Language (XBRL) adoption and the firm 

conversion target dates (SEC, January 2009). The mandate 

stated the largest domestic and foreign public companies 

that use U.S. Generally Accepted Accounting Principles 

(GAAP) to file their financial statements in XBRL format 

by June 15, 2009
1
: medium-sized filers by June 15, 2010, 

and the rest of the filers, either using U.S. GAAP or 

International Financial Reporting Standards (IFRS), by June 

15, 2011 (Fang 2010). 

The new rules are intended to make financial 

information easier for investors to analyze and to assist in 

automating regulatory filings and business information 

processing. The XBRL system lists information at both the 

document level, such as the entire set of financial statements 

for a given firm, and the data element level, such as 

individual accounts like inventory. In XBRL interactive 

data, or data tagged at the data element level, can function 

across multiple and/or different platforms or application 

programs. Thus, XBRL has the potential to increase the 

speed, accuracy and usability of financial disclosure, and 
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eventually reducing costs for financial reporting as well as 

business transaction processing. 

At the same time as the company files its financial 

statements or related registration statement with the 

commission in XBRL format, the SEC also requires a filer, 

for a minimum of twelve fiscal months, to post its financial 

statements in interactive data format on its corporate 

website. The new rules will not eliminate or alter existing 

filing requirements that financial statements, the 

accompanying reports and schedules be filed in the 

traditional format. The SEC believes that some investors 

and analysts may wish to use the traditional format to obtain 

an electronic or printed copy of the entire registration 

statement or report, either in addition to or instead of using 

interactive data. 

In the traditional format, one painstakingly sifts through 

pages of statements and footnotes in order to extract the 

relevant data. Currently, whenever financial statement data 

are needed for fundamental analyses, users can download 

the related financial statements directly from the SEC’s 

EDGAR system. For efficiency and/or accuracy, many users 

often turn to paid commercial data providers to obtain the 

necessary data. With Interactive Data Electronic 

Applications (IDEA), we will be able to retrieve these data 

directly from the SEC’s website. 

Beneficial to all users, this change is particularly 

important to resource strapped institutions, such as small 

businesses, students and universities. Using the industry 

standard tool of Excel, without expensive proprietary XBRL 

modules, these institutions can procure detailed information 

quickly, efficiently and at minimum cost. 

The motivation for this paper is two-fold: to explain the 

basic concept of XBRL and to demonstrate the retrieval 

process in Excel in the classroom or in a workshop. Its 

contribution lies in drawing attention to the possibility of 

bypassing commercial data providers, for end users in 

financial services and at educational institutions. 

 

Exhibit 1:  SEC Web site 
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Exhibit 2:  View Filing Data Window 
 

 
 

The paper is organized in the following manner: section 

2 explains some basic concepts of XBRL (Bizarro and 

Garcia 2010). Section 3 demonstrates XBRL data retrieval 

in Excel emphasizing how this would be useful for teaching 

and or employee training. Conclusion follows. 

 

SOME BASIC XBRL CONCEPTS 

 

At the beginning, listed companies filed their required 

reports with the SEC using paper. Later, during  the 1990s, 

they filed electronic reports utilizing the EDGAR database. 

Now, aiming to provide investors and all other interested 

parties with faster and easier access to financial data, the 

SEC is upgrading the EDGAR system to another electronic 

platform: IDEA. In doing so, it is increasing capital market 

efficiency (Fang 2005 and Malkiel 2003) through 

information efficiency. 

For illustrative purposes, assume that an investor wants 

to make a substantial investment. This investor chooses to 

perform a set of five-year profitability trend analyses for a 

pair of candidate companies to finalize his investment 

decision. Twenty-five years ago, when filing was paper-

based, it would be necessary to first spend many hours in 

the library collecting information by hand from volumes of 

loose-leaf annual reports and then to perform all the 

necessary calculations. With the electronic system, only a 

fraction of that time is needed to collect similar data on 

either EDGAR or some other online data warehouse.  This 

represents an amazing gain in efficiency. EDGAR is now 

upgraded to IDEA, a more efficient electronic system. 

EDGAR provides users with electronic data at the 

document level. Companies file their financial reports in 

SEC prescribed forms, providing all the necessary data at 

the document level. This means that to perform your 

analysis, you first have to sift through hundreds of pages of 

financial statements. Then you need to manually re-enter 

this information in a spreadsheet or some kind of specialty 

software. Manual data entry is both time-consuming and 

potentially inaccurate. 

IDEA, retaining some elements of EDGAR, uses 

XBRL to provide users with electronic data at the data 

element level (Phillips, Bahmanziari and Colvard, 2008). 
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Financial reporting in XBRL provides accessibility, 

comparability and usability (Taylor and Dzuranin, 2010). 

Firms post on line a single XBRL instance document. This 

provides universal accessibility. The document contains 

industry specific approved taxonomies.  The taxonomies 

serve as the means to tag data, footnotes and auditors 

reports. Tagging permits the association of a taxonomy 

element with a concept. This provides comparability across 

firms, search facilitated technology for comparison and 

transparency. Usability is enhanced via the standardized 

tags and elimination of transcribing data from one format to 

another, for example, from HTML to an analysis tool. 

Information is directly downloaded and then imported to a 

spreadsheet. 

Now any application with XBRL processing capability 

can automatically import, cut, rearrange and present the 

necessary data in any shape or form according to user needs. 

As such, these applications are interactive. The elimination 

of the manual re-keying process not only improves data 

transmission efficiency, but also, and more importantly, data 

accuracy. IDEA has many advantages over EDGAR in 

terms of both speed and accuracy. Computers are much 

more efficient in searching, storing, and arranging 

information at the data element level, not just the document 

level (Fang 2009). In the next section, we will review 

examples of the use of information for financial analysis.  

 

AN EXAMPLE FOR XBRL DATA RETRIEVAL:  

ASSET ALLOCATION FOR A STUDENT 

INVESTMENT FUND 

 

The highlight of several business schools is their 

student investment funds. Student participation in the 

management of investment funds has been demonstrated to 

be a valuable technique for training individuals for the 

investment sector. The use of Microsoft Excel and XBRL 

makes this a cost effective proposition for most business 

schools. The following section demonstrates the 

convenience of XBRL in financial information retrieval 

using the ubiquitous tool of Microsoft Excel.           . 

 

Exhibit 3:  View Filing Data, 2008-2010 
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This method is more efficient than the hand collection 

of data required to obtain data from 10-K reports filed with 

the SEC only a few years ago. This section provides a 

detailed classroom demonstration of the advantages of using 

this method for data retrieval from the SEC’s IDEA 

platform into Microsoft Excel (2010). 

A group of students, enrolled in an on-campus student-

led investment fund class in finance, were assigned to pick 

the best military contractor to invest $2 million or 10% of 

the allowed investment fund. Using the capital asset pricing 

theory (Sharpe 1964), their professor has narrowed the 

candidates down to the final two companies: Lockheed 

Martin Corp. (LMT), and Honeywell International Inc. 

(HON). The students’ task was to finalize the investment 

decision by undertaking a trend analysis comparing profit 

margin ratios over the last five years. In this section we 

demonstrate how the student can accomplish the task to 

retrieve the financial statements directly from the SEC’s 

Next-Generation EDGAR system with Microsoft Excel. Our 

demonstration expands on that of Tribunella and Tribunella 

(March 2010) using Microsoft Excel 2007. The SEC has 

upgraded its IDEA system since then, so now some of their 

instructions are no longer functional. We extend their 

methods to the student-led investment fund using Microsoft 

Excel 2010.
2
 

To begin, open a new Excel workbook. Immediately 

after opening a new Excel workbook, determine whether the 

“Developer” tab is displayed in the Ribbon. If not, left-click 

the File tab and then left-click on “Options” in the pane on 

the left-hand side This opens the “Excel Options”  window.    

Choose   “Customize  Ribbon” in the left pane.  In the right-

hand column beneath “Customize the Ribbon”, check the 

box next to “Developer." 

 

Exhibit 4:  Filing Window Detail 
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Left-click the “OK” button to confirm the selections and to 

return to the worksheet.  

The next step is to download the necessary data. After 

opening an internet browser, go to the SEC website by 

typing in the web address (http://www.sec.gov) or by 

searching for “SEC” in an internet browser and clicking on 

the SEC link. From the SEC’s homepage, it is now possible 

to search for any one of the companies registered with the 

SEC by clicking on the “Search” button in the upper right 

corner (Exhibit 1). The SEC provides a few different ways 

to search company filings. For this sample analysis, the 

firm's financial statements will be located using the name 

search feature.  First,  type “Lockheed Martin Corp” into the 

“Company Name” field on the left search pane. Next, left-

click on the “Find Companies” button. In the “Search 

Results” window, a list of all the documents that the 

company filed with the SEC is displayed chronologically, 

forty documents at a time, together with all the pertinent 

registrant information. A blue “Interactive Data” tag is used 

to identify all the filings in XBRL format. 

By scrolling down the list, one can find the 2010 10-K 

report filed on 2011-02-25 with the SEC. Left-click on the 

“Interactive Data” tag, which will open the “View Filing 

Data” window (Exhibit 2). Left-click on the “Financial 

Statements” tag on the left pane and select “Consolidated 

Statements of Earnings” from the dropdown list, granting 

access to Lockheed Martin Corp’s consolidated income 

statements from 2008 to 2010 (Exhibit 3).
3
 Left-click on the 

printer icon to print a hard copy and use it as a reference to 

check the accuracy of the XBRL data that will be 

downloaded later. 

It is possible to save the information to a PC by first 

opening a new Microsoft Word document, switching back to 

the internet browser to copy the screen by holding down the 

“Ctrl” (“Fn” on some laptops) key and then press the 

“PrtSc” key on the keyboard. Then switch back to the Word 

document, right-click, then either select “Paste” or press 

“Ctrl” and “v” on the keyboard.  These  procedures will 

copy  the screen shot to the Word document, which can then 

be saved for further use.
4
 A second option exists for saving 

the reports in the Portable Document Format (PDF). Most 

internet browsers have the capability of either saving or 

“printing” a web page as a PDF. The major advantage with 

this second option is that instead of simply saving an image 

of the report, it is possible to save a searchable text 

document, significantly reducing time spent searching for 

relevant information later on in this process 

Next, download the financial statement data in XBRL 

format. Switch back to the internet browser, navigate back 

to the document list window and scroll down to the same 

10-K report but left-click on the “Documents” button this 

time. A “Filing Detail” window will open. Scroll down to 

find the file with the description “XBRL INSTANCE 

DOCUMENT” marked “Seq. 17” for this document. Right-

click the file link named “lmt-20101231.xml” and choose 

"Save Target As …” see Exhibit 4.  

We recommend saving this file in the “XBRL” subdirectory 

that was created earlier. 

The next step is to import the XBRL data needed for 

analysis to an Excel worksheet. Left-click on the Excel tab 

on the task bar at the bottom of the window. Open the 

instance document by left-clicking on the File tab, then click 

“Open”. Next, navigate to the “XBRL” subdirectory and 

select the “lmt-20101231.xml” file. After pressing the 

“Open” button, Excel can recognize that the file is in XML 

format.
5
 This will provide an “Open XML” dialog box. 

Select the “Use the XML Source task pane” option and 

press the OK button. A warning box will appear, reporting 

that “…Excel will create a schema based on the XML 

source data.” Press the OK button to proceed. An “XML 

Source” pane will open on the right side of the worksheet. 

In order to map the data quickly and accurately, we 

recommend that displaying the associated value  of  each  

XML  data  element. Left-click the “Options” button at the 

bottom of the “XML Source” pane and check all the 

options. 

The next step is to map the XBRL data elements 

equivalent to “Net Earnings” on the Excel worksheet. The 

problem is that XBRL is still in its infancy and all the 

XBRL taxonomies (XBRL financial statement filing 

standards for various accounting standards and/or industries, 

e.g., IFRS vs. US GAAP, general industry vs. insurance 

industry) provide many different labels to tag the same or 

similar data elements (Capozzoli and Farewell 2010). This 

presents a formidable challenge for the users—especially an 

XBRL novice. Looking for the correct tag from a list with 

hundreds of data elements for any new instance document is 

like searching for a tiny needle in a huge haystack because 

we do not know which label a given company used to tag a 

particular data element. This is why it was previously 

recommended to first either print out a hard copy of the 

Consolidated Statements of Earnings or to save a screen 

shot of it, and then to choose to display the data value in the 

“XML Source” pane. 

After scrolling about 3/4 of the way down the list on the 

“XML Source” pane, a data element named 

“ns2:NetIncomeLoss” with a <value> of “3217000000” and 

“ContextRef (Duration_1_1_2008_to_12_31_2008)” will be 

visible. Refer to the hard copy or screen shot of the 

Consolidated Statements of Earnings for Lockheed Martin 

Corp. (Exhibit 5); it can be verified that the two amounts 

match each other. It is also possible to learn that the 

company uses the label of “ns2:NetIncomeLoss” to tag its 

“Net Earnings”. 

Next, click on <value> and drag it to either cell (A1) on 

worksheet or to any other field appropriate for mapping the 

“Net Earnings” or XBRL data elements labeled 

“ns2:NetIncomeLoss.” Left-click on the “Developer” tab in 

the Excel Ribbon on top of the window and choose 

“Import”. Excel will display an “Import XML” window. 

After this, navigate to the “XBRL” subdirectory to select the 

same “lmt-20101231.xml” file. After pressing the “Import” 

button at the bottom of the window, Excel will import and 

place Lockheed Martin’s “Net Earnings” for all the 
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reporting periods (2008, 2009 and 2010) below the XBRL 

data element of “ns2:NetIncomeLoss”. We recommend 

labeling the data with the corresponding year by referring to 

the hard copy or screen shot of the Consolidated Statements 

of Earnings (Exhibit 5).  Following the same procedure, 

scroll down the XML Source pane, about 4/5 of the  way  

down  the  list,  to  find   the “Total Net Sales” or  the 

XBRL equivalent data elements of “ns2:SalesRevenueNet” 

and map it to cell “D1” on the Excel worksheet. Following 

the procedures described above, repeat the same process for 

the “Total Net Sales” data for the last three years. Right-

click the worksheet tab “Sheet 1” at the bottom of the 

window and rename it as “LMT_Imp” and “Sheet 2” as 

“Report”. Save the workbook in the “XBRL” subdirectory 

as “XBRL_Fin”. Later, we will use the “LMT_Imp” 

worksheet as a template for importing all the necessary 

XBRL data and the “Report” worksheet for the analyses and  

reports. On the “Report” worksheet, choose a section for 

calculating the five-year Profit Margin Ratio change and 

trend analysis for Lockheed Martin Corp. The next step is to 

copy all the necessary data from your “LMT_Imp” 

worksheet to your “Report” worksheet. You should also 

setup all the formulas needed for the Profit Margin Ratio 

change trend analysis. For example, the formula in cell F6 is 

“=F3/F4,” and in cell F8 is “=(F6-E6)/E6”. You only need 

to enter each of these formulas once then copy and paste it 

to the other years, see Exhibit 6. 

Following the same procedure, you can download LMT’s 

financial statement data for 2009 and for many years to 

come. Now that you have setup the XBRL mapping and 

Report worksheet, you need a minute or two to retrieve the 

data without any “input errors”—a net gain in both 

efficiency and accuracy. 

 

Exhibit 5:  Mapping and Importing XBRL Data 
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Exhibit 6:  The Report Worksheet 
 

 
 

To complete this demonstration we wish to indicate 

that, with the exception of the companies that took part in 

the SEC’s voluntary XBRL filing program, most have 

chosen to file their financial reports in XBRL format for just 

a year or two. It is possible to continue to download  

financial statements at the document level from EDGAR by 

following similar procedures to search for the target 

company (LMT for this example). After  navigating to the 

“Filing Detail” window (Exhibit 4), click on the “d10k.htm” 

under “Document” on the top pane. EDGAR will provide 

the full 10-K report. It will be necessary to manually sift 

through the report to find the data needed for your analysis 

and enter the amounts in the “Report” worksheet.  Hand-

collection of data is much slower than the XBRL import, 

and more importantly, much more susceptible to “input 

errors”. However, a search for information online or in a 

saved PDF may still improve search accuracy and 

efficiency. These formats maintain the integrity of the 

reports at the document level. By using the search function, 

(usually “Ctrl-f”), one can instantly locate every occurrence 

of a given word or phrase in a document. This method is 

still subject to human error; beware of misspellings. 

Finally, it is important to follow similar procedures to 

setup a separate Excel workbook as an XML import 

template for Honeywell International Inc. The finished 

report should look like the final report in Exhibit 7 (“1” is 

used as a placeholder for missing data). 

 

CONCLUSION 

 

Over the past two years, the SEC has made 

considerable progress in building a functional IDEA system. 

It has successfully implemented the Next-Generation 

EDGAR System, which provides its users with many 

convenient search options such as multiple links and RSS 

(really simple syndication) feeds. This new system also 

seamlessly combined the old document level EDGAR 

system with the new data element level IDEA system. Thus, 

a user can retrieve a company’s financial reports in XBRL 

format as well as in electronic document format. 

In this article, we have explained related concepts and 

demonstrated detailed steps describing how to directly 

retrieve XBRL data from reports filed with the SEC and 

import those data into Excel. To be better prepared to handle
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Exhibit 7:  The Final Report 
 

 
 

this challenge in the near future, business schools and 
institutions with modest resources will still be able to train 
their faculty, students and/or staff with XBRL theories and 
skills. By now, most of the big software houses have 
developed their proprietary XBRL modules to work with 

their Enterprise Resource Planning systems for filing 
financial reports with the SEC as well as retrieving IDEA 
data for financial analyses. However, Microsoft Excel 
remains the most cost effective and accessible XML-capable 

software for most users of more modest resources. 
 

ENDNOTES 
 

1. There are approximately 500 such companies with 
worldwide common equity float above $5 billion at the end 
of the second fiscal quarter of their most recently completed 
fiscal year. 

2. Everyone has different preferences and skill levels 

when using Excel and internet browsers. The authors are 
average users; the following procedures reflect their own 
preferences and abilities to get the job done using Microsoft 
Excel 2010. 

3. In Exhibit 5, the accounting line items are interactive. 
Each line item has a filing code. For example, left-click on 
“net earnings” in Exhibit 5. This opens a window with three 

items – definition, references and details. Left-click on the 
details tab. This will show you “name:us-gaap_net income 
loss”. This filing name is to be noted. It is used to identify 
net earnings when you are importing data. 

4. We would like to take this opportunity to promote a 

good habit to help organize computer files in the most 
logical way for easy access. The authors created an “XBRL” 
subdirectory on a PC’s “C” drive to store all the files related 
to XBRL research projects.  This Word document was saved 

in that subdirectory as “LMT_HON,”a mnemonic file name. 
When working on multiple research projects concurrently, 
utilizing this filing system may be helpful in the retrieval of 
files at a moment’s notice. 

5. XBRL is one of the many dialects of XML. 
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